Chapter 2

Navigating Research Insight

This chapter describes the various windows, toolbars and buttons you will see in Standard &
Poor’s Research Insight. It shows you how to navigate through Research Insight by describing
the elements of the

*  Welcome to Research Insight window
*  Research Insight desktop

¢ Research Assistant

*  Report Assistant

¢ Chart Assistant

*  Run Assistant

e Look Up List
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Welcome to Research Insight Window
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The Welcome to Research Insight window is your entry to the basic functions of Standard &
Poor’s Research Insight. When you click a button or corresponding text with your mouse, you
will be taken to one of the many different functions of Research Insight. If you do not want this
window to automatically display when you enter Research Insight, click the Display on
Startup check box to turn off the default setting. Below is a description of each icon on the
Welcome to Research Insight window.

Research Assistant: define your screening criteria, then develop custom
reports and charts, or access pre-defined reports or charts.

Report Assistant: develop custom reports, then define your screening criteria.
Chart Assistant: develop custom charts, then define your screening criteria.
Company Highlights: run a financial highlights report for one or more companies.
Library: retrieve Business Descriptions and Trends and Projections.

Open Screen: open pre-defined screens or develop a new screen.

Open Report: open pre-defined reports or build a new report.

Open Chart: open pre-defined charts or build a new chart.

Open Set: open pre-defined sets or develop a new set.

Prices, News and Headlines: access Real Time for current prices and news.

Closes the Welcome window and displays the Research Insight desktop.




Chapter 2 - Navigating Research Insight

Research Insight Desktop
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Research Assistant: define your screening criteria, then
develop custom reports and charts, or access pre-defined
reports or charts.

Company Highlights; run a financial highlights report for
< one OPI)‘ m};re gom%anies. g P

Open Screen: open pre-defined screens, or develop a new
screen.

Open Report: open pre-defined reports, or build a new
report.

|« Opens Real Time for current prices and news.

The desktop provides another way to access all the features of Research Insight. It displays when
you close the Welcome window, or whenever you click Cancel in the Research Assistant. To

return to the Welcome window click the

- (Welcome) button or select Welcome to

Research Insight from the Help menu. The buttons on the toolbar at the top of this
window are described below.

Create a new report, chart, screen or set

Open an existing report, chart, screen or set

Context sensitive help
About Research Insight

Save Launch Library
Print Welcome Window
. V=N MR = = ]
= S NS G a3
Copy Look Up T
Cut Launch Company Home Page
Paste

Launch Market Insight

Run a report, chart, screen or set
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The Research Assistant

The Research Assistant is a wizard designed to walk you through screening the database. The
Research Assistant can also link to other wizards in Research Insight to build reports or charts
with the results of your database screen. For more information on how to screen the database
with the Research Assistant, see Chapter 3 - Screening with the Research Assistant.

Following is a description of each version of the three Research Assistant windows.

Research Assistant - Step 1 Window

Reseaich Assistant - Step 1 [Money Management] x|
Enter LCompanies Look Up Initial St Change the
company £ ED @l [ Change 5=t | <€—— initial set of
tickers here Eind Similar Companies Companies here
Walliation I Markﬂtl InslilulinnaIHuI\:I\rgsI Turnamund] Furﬂ;

NAICS 4 y =
Select one Industy Sector I Market Yalue |> d I1[IIII o :ll
t Economic Sector

GICS-Sacto ; s =]
9 C_Ompare E\ES-E?DuDr ™ Price to Eamings I: = I'I B0 =]
similar BIC5-Industy =l | =

. o I™ Price to Baok < - s =

companies Periad Sekection - =

Current Period [~ PricetoSales I; d |1 5 ::ll Narrow your

screening criteria

Open Screan. | Clear I I~ Foward P/E

]
o
=

| | = here
Classic Yiew Reset
= — 5 o =|
™ Free CFL per Share | > |1 0.0 =
Save Screen
Right-click on description for .
’7 Save Saveds | definition of indicator Customize...

cooct [ Mewts | concel | He |

This window lets you search for companies using specific screening criteria. You can conduct a
broad search for companies that are in the same industry sector, economic sector, SIC, NAICS

or GICS Code or country.

Using the Change Set feature, you can narrow your search criteria by selecting a specific set of
companies as your starting point (e.g. S&P 500). Screening criteria can be narrowed further by
using the tabs on the right side of the window, checking the necessary fields under each tab and
selecting the ranges from the drop down lists.
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Following is a description of each button displayed in this window.

Opens the Look Up List where you can search for a company by

name or ticker symbol.

Opens the Initial Set dialog box where you can choose a set of
Change Set

companies as the starting point for your screen.

Opens the File Open window, which allows you to open predefined or
Open Screen..) .
previously saved screens.

Clear Erases information you have entered in the window.

Opens the Research Assistant - Step 1 Classic View window, for

Classic View . .
access to more advanced screening options.

Restores the default settings of the window.

Saves your screening criteria for use in future analysis.

¢

HiEl e

Saves your screening criteria with a specific name in a specific

ol location.

Opens the Custom Indicators window, which allows you to customize
Indicator Groups (e.g. Valuation, Market, etc.) and Indicator Items
(e.g. Beta, Sales, etc.).

Customize...

Next > Opens the Research Assistant - Step 2 window.

Cancal Closes the Research Assistant.

Help Displays step-by-step Help topics.
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Research Assistant - Step 1 - Classic View Window

Reseaich Assistant - Step 1 - Classic Yiew [Money Management]

Enter your Enter your
base set XA _lﬁ Lk | formulas
|nf0rmat|0n\\ Size | Formula [Min[Max [ Passe here

here Linel

$Line1+{"ibm"} Line2
$Line2 SIC="IBM™:SIC Line3
$Line3 mkvalm>1000.0 Lined

Open Screen... Clear | Bun Save Screen
Screen View | Reset | Run with Time Periods... | Erint | ’Vﬂl ﬂl

¢ Hack Concel | Hep |

This window allows you to view and modify the underlying Base Set and Formulas used in
developing your screen. To modify information, click on the field, enter the new information on
the command line and press Enter on your keyboard. This window is accessed by clicking the
Classic View button on the Research Assistant - Step 1 window. If you make modifications in
this window, you cannot return to the Research Assistant - Step 1 window. Following is a

description of each button displayed in this window.

Opens the File Open dialog box, where you can open predefined or
previously saved screens.

Returns you to the Research Assistant - Step 1 window (only if you

Screen View . . .
have not modified any information).

Clear Erases the information you have entered in the window.
Reset Restores the default settings of the window.

Calculates the results of your screen.

Run with Time Periods... Calculates your results for a specific time period.

Prints the formulas used in developing your screen.
Saves your screening criteria for use in future analysis.

Saves your screening criteria with a specific name in a
specific location.

2 e g
@ | |2 2
| (@ . g
e -

Opens the Research Assistant - Step 2 window.
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Research Assistant - Step 2 Window

Reszeaich Assistant - Slep 2 [Money Management) Add
Company List | DiplayMode |~ Add Company to sel companies
Company Coud 17 & Names [FOn - to your set
The set .of APPLERA CORP CELERA GENOMI | || ~ Ticien | Add Conpary | Look Up here
companies BARRA INC
COMPUTER SCIENCES CORP ~ Save Sat - Added Conpanies
that passed EARTHLINK IN

EBAY INC

c sz | Companies
your screen ELECTRONIC DATA SYSTEMS OO - added to
EXODUS COMMLUNICATIONS INC Sayehs.
appear GALILEC INTERNATIONAL INC your set are

here HOMESTORE.COM INC emove Company Added i
INFOMET SERVICES CORP Bl I | B o ht] glsplayEd
INTL BUSINESS MACHINES CORP
?ERRAGEF_'\{-ETS\EOR'QANCP e Save Sceen—— [ Removed Companes - ere
A NETWORKS S A -5P ADI
Save... .
VABo e m‘l Companies
! = i removed from
Bomove Compary | | Market e Capay your set are
I .
i g ; displayed
here
< Back I Hext > I Cancel I Help I

This window displays your screening results based on the criteria established in the first Research
Assistant window. In this window, you can add companies to your set or remove any companies you
do not want induded in your set. You can also display the set by company name or ticker symbol.
Following is a description of each button displayed in this window.

R

2| | [
¢ @

Reset

Remove Company from Added list |

Restare Company

® 1

Opens the Look Up List where you can search for a company by
name or ticker symbol.

Adds the ticker in the Add Company to set field to your set.
Saves your set or your screen.

Allows you to save your set or your screen in a specific location with
a specific name.

Restores your set to the last version saved.

Removes the highlighted company from the Company List and from
the Added Companies list.

Removes the highlighted company from the Company List.
Inserts the highlighted company back into the Company List.

Launches Market Insight, which gives you on-line access to
up-to-date financial information through reports such as Country
Overviews, Risk Reports, Company Profiles, Balance Sheet
Statements, Income Statements, and Financial Analysis Reports.

Note: Market Insight requires a separate subscription from
Research Insight.

Returns you to the previous window (Research Assistant - Step 1).

Opens the Research Assistant - Step 3 window.
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Research Assistant - Step 3 Window

Select another
Research Insight
function here

This window links the Research Assistant to additional Research Insight functions. The Report
Assistant and Chart Assistant options take you to wizards that allow you to build
customized reports or charts. The Open Report and Open Chart options allow you to run a
pre-defined report or chart or build new ones. The Company Highlights option runs a
company highlights report. Selecting Finish returns you to the Research Insight desktop.

Research Assistant - Step 3

E  Fopon Assistant

| g‘k  Chart Assistant

U © Open Repon

Al © OenChan
E ~ Company
i Highlights
 Finigh

Crente a cusiom
SCIEENnG criterin

on the 1

Cyeate & custom chart based on the companies that passed your
screamng cribena.

Open & pre-defined repont based on the companies that passed
YOUF SCTEEning Crierie.

Open a pre-defined onth i d your
SCO0Ening critria

Fiun the Compamny Highlights report for the companies that passed
WOUr SCTEER

Fietum to the Research Insight deskiop.

<Back Net> Cancel | Help

Following is a description of each button displayed in this window.

Returns you to the previous window (Research Assistant - Step 2).

Opens the next window based on the selection made.
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The Report Assistant

The Report Assistant is a wizard designed to walk you through building and running custom
reports. Depending upon which type of custom report you choose to work with, the Report
Assistant can consist of up to three windows. The Report Assistant can be used as an extension
of the Research Assistant to build a custom report with the results of your database screen or
by itself with the aid of the Run Assistant as the method you use to screen the database. For
more information on how to work with a custom report using the Report Assistant, see

Chapter 4 - Reports.

Following is a description of the three Report Assistant windows.

Report Assistant - Step 1 Window

Select a

format for
reports run in
the current

time period

Select a
format for

reports run
for a specific
period of time

Click here

to begin
creating a
free-form
report

Report Assistant - Step 1 [Money Management] x|
EXAMPLE <
€ Companies vs ltems
~ Historical Analysis Gompany Mame Mrkt \slue Mthly | PricetoEarnings | PricetoSales
€ ltems vs Companies Houghiton Mifflin 1,114.296 22.712 1.410
r— Items vs Time McGraw-Hill Co 6,775.262 12.864 1.956
F C
o e Fimarders Diges!. 2544813 §2.932 0.823
¢ Time vs ltems
For a Company
—Eampary [
3 Blank Report 174
<Back | Hew> |  Cancel | Hep |

Shows how your
report will be
formatted

If you selected
Companies vs.
Items under
Current Time
Period, enter the
number of
companies to
include in your
report here

This window is used to define specific report parameters when building your own report. It
opens when you choose the Report Assistant option on the Research Assistant - Step 3

window, or when you click the Report Assistant button on the Research Insight desktop.

You can create a report using the current time period, or you can choose to compare data

items and companies over a specified period of time with an historical analysis report. If
you are building a report for the current time period and you select Companies vs.
Items, you can choose to display multiple companies in your report by entering the
number of companies in the Company Count field.

Following is a description of each button displayed in this window.

Returns you to the previous window.

Opens the Report Assistant - Step 2 window.
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Report Assistant - Step 2 Window

Report Assistant - Step 2 [Money Management] x| Y dd
ou can a
~ Item Giroups Newliem—LackUp other items or
Select the > & Vet € Rafios {51 ot — functions to your
broad Item € Growth € First Call Earnings Est report here
 Selected ltems p
Groups and € Income Stmt-12MM € LLS. Econoric
specific € EPS & Shares € Market & Retums The items vou
data Items € Company Specilics (Eris ~—— have addezi/ will
to include in - appear here
your report =
Piice/Eamings - Monthly =
Price/Cash Flow-Share Mily Add Al
Price to Book =
Beta
. Curtent 12mm EPS - Basic Bemove << i
Dlsplays the Price/Sales per Share Daiy sale 15 DlSpIayS the
I d Price/E atrings - Daily selected item’s
_SE ecte Book Value per Shaie =l | Secreen Iherml Kove I laxz= Pleiiig I mnemonic
item’s . rmkvalm =] Defirition_ | s ta includz items in Chat
mnemonic
¢ Back e Cancel | Hep |

This window is used to select the broad item groups and specific data items within a

group/category that you want to appear in your report. Following is a description of each button
displayed in this window.

Adds new items chosen from the Look Up List to the Selected Items area.

Opens the Look Up List where you can search for a specific item to add
to your report.

Opens the Customize Item Sets dialog box where you can modify or

Customize. .. . .
create new item sets and items.

Add >> Adds the items selected from the Items area to the Selected Items area.

Adds all the items in the Items area to the Selected Items area, which

Add Al > . L .
lists all items that will appear on your report.

L] P

Removes any highlighted item(s) from the Selected Items area.

|1z
o
2
e
M
a

Opens the Item Set Definition dialog box, where you can modify the
highlighted Selected Item.

Ofpens the Item Definition dialog box where you can view the definition
of t

he highlighted Item

Returns you to the Report Assistant - Step 1 window.

Definition...

< Back

If you are running an historical analysis report, this button opens the
Report Assistant - Step 3 window.

If you are running a current time period report, this button opens your

Finish
completed report.

Adds the items you used to screen the database to your report.

)

[=

creen ltems

Moves the selected item up or down one position in the list; this affects
where the item will appear in the report.

Move Up
Move Do

=

N
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Report Assistant - Step 3 Window

Report Azzistant - Step 3 [Money Managamant]
Enter the Pedods Stannent
Beginning and T et sy o e report e
Ending Time Begiing Period Ending Peiiod Sebect the aligrevers, thal vl be appbed 1o ol Select the
Periods for e LT | TETI ':mln"flw alignment to
your report B —— i apply to all the
€ Relgive & Monthly items here
& Absoie ekl _ (e.g. Annual,
Choose a gt P ‘ Quarterly,
Relative, R et o s ek ) Monthly, etc.)
Absolute or TRt o e et e ol e
Calendar ol
format f Enssle ot honment coters

cpack | TR Concel | Hep |

This window displays after you choose to build a report based on an historical analysis and
select the item categories and specific items within a category that you want to appear on your
report. This window lets you enter the Beginning and Ending Periods you want to use when
you run historical analysis reports.

This window also gives you the option of selecting a Relative, Absolute or Calendar time period
for your report.

The Relative time period requires a point of reference in order to determine which time period
is being referenced (e.g. the last three years, the most recent four quarters, etc.). Relative enables
you to rerun your report in subsequent periods without changing the reference. The default
Beginning and Ending periods are O where O represents the most current time period (e.g.
annual, quarterly, monthly, etc.) for which data is available. One period prior to the current
period is indicated by [-1], two periods prior to the current period is indicated by [-2], etc.

The Absolute time period tells the exact time period and ensures that a specific time period’s
data is returned (e.g. MayO1 for May 2001 or Y01 for fiscal year 2001).

The Calendar time period is an exact calendar year, quarter, month, week or day. The calendar
time period is always the exact year in which the time period ends. For example, suppose a
company's fiscal year-end is May 2001. The calendar time period for annual data is 2001.

If you have selected data items with different periodicities (e.g. annual sales, quarterly EPS), this
window will also prompt you to select an alignment for the data.

Following is a description of each button displayed in this window.
Returns you to the previous window (Report Assistant -Step 2).

— Displays the Run Assistant window or your completed report,
depending upon from where you accessed the Report Assistant.
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Report Window

|
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This window displays a report according to the companies and criteria you established in the
Research and Report Assistants. Under the File menu, you can choose to Close or Save your
report, create a New report or Open an existing report. If you close or save your file, you will
be taken out of the Research Assistant.

Click the (Run) button to access the Run Assistant window where you can modify your
screening criteria for a report. To rerun the report with different data items, click the [
(Rerun Assistant) button or select Rerun Report/Chart Assistant from the Report menu.
To return to the Research Assistant click the (Research Assistant) button on the
desktop. B
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The Chart Assistant

The Chart Assistant is a wizard designed to walk you through building and running custom
charts. Depending upon which type of custom chart you choose to work with, the Chart
Assistant can consist of up to three windows. The Chart Assistant can be used as an extension
of the Research Assistant to build a custom chart with the results of your database screen or
by itself with the aid of the Run Assistant as the method you use to screen the database. For
more information on how to work with a custom report using the Report Assistant, see

Chapter 5 - Charts.
Following is a description of the three Chart Assistant windows.

Chart Assistant - Step 1 Window

Ch )
Select a b comonrn | Displays what your

= : )
chart style o chart will look like
here ———> 8

™ High. Low. Close

High, Low, Close. | i
= L o o3| Selgct atime
L period here

" Lina
Select one P
or multiple
companies Companies per Chant _
to display & Ong Company c F @ Annwsl  C Montly Dty Select a time
inyour —p» o o & Historical Analysis fo rwesy —<— reference here
chart

<Back et > cancel | Heip |

This window is used to define specific chart parameters when building your own chart. It
displays when you choose the Chart Assistant option on the Research Assistant - Step 3 window
or when you click the Chart Assistant button on the Research Insight desktop. You can select
the chart style along with how many companies are to appear on the chart. In addition, you can
create a chart using the current time period, or you can choose to specify the period of time for
an historical analysis chart. Following is a description of each button displayed in this window.

Returns you to the previous window.
Opens the Chart Assistant - Step 2 window.
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Chart Assistant - Step 2 Window

. Youcan select
Chait Assistant - Step 2 [Money Management) additional items

not displayed on
) Ibem Groups New ltem Look Up h .
Activate these © Vabation € Retion | the screen using
general item € Growh £~ Fist Call Earnings Est the Look Up List
groups and —— 3 (" Income Stmt - 12MM € 15 Economic
then select & EFS &Shares € Market & Returrs The items you
specific data " Company Specifics Customize: | — have selected for
items to — your chart
include in your EFS Basic Exc Evira lle = appear here
chart e fESey S
EPS Dilitad In. F i ltams. ﬂl The mnemonic
[ om Uperaborns
EPS Basic Exc Extra Itm Hstd Remave ¢ |
Eorm Shasees fon B ase: EFS [ooeps  <€—=-—£a—} 1 for each selected
hares lor Diuted EPS .
Com Shates bor Basic EPS At = — | Mova Up I Mowe Down | item appears
IODODS 3: Delji.mnl ™ Add checks to include items in Chart here
e | Heo |

This window is used to select the broad item groups and specific data items within a
group/category that you want to appear on your chart. Following is a description of each button
displayed in this window.

Adds new items chosen from the Look Up List to the Selected
Items area.

<«

Opens the Look Up List where you can search for a specific
item to add to your chart.

Opens the Customize Item Sets dialog box where you can modify or

Customize... . .
create new item sets and items.
Add >> Adds the items selected from the Items list to the Selected Items area.

2ddals Adds all the items displayed in the Items list to the Selected Items
= area, which shows all items that will appear on your chart.

Bemaove << Removes any highlighted item(s) from the Selected Items area.

Edi Opens the Item Set Definition dialog box, where you can modify the
= highlighted Selected Item.

Definitiarn... Opens the Item Definition dialog box where you can view the

definition of the highlighted item.
<Back Returns you to the Chart Assistant - Step 1 window.

Nedas If you are running an historical analysis report, use this button to open
— the Chart Assistant - Step 3 window.

Enoh If you are running a current time period report, this button opens your
completed chart.

Screen ltems Adds the items you used to screen the database to your chart.

Move Lp Moves the selected item up or down one position in the list; this

T affects where the item will appear in the chart.
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Chart Assistant - Step 3 Window

Chait Azziztant - Step 3 [Money Management]
Enter the RIS Abgoment
Beginning and £ec e bagoiing el wicng P e fome you seced for e epat have
Ending Time Beginring Period Ending Pesiod Solec the sbgrment thal wll be sppied to o
Periods for your ——[& = [ = = sl Sglect the
chart L - alignment to apply
smm, st e o i 3] to all the items
Fies a here
Choose a _>: Cldouts : 2
Relative, Absolute i - _
or Calendar e e o oo
format Check this oplion to enable al signment
ophions.
I™ Enable oll aligrment options
<Back [ Fsh ]|  Cancel | Hep |

This window displays after you choose to build a chart based on an historical analysis and select
the item categories and specific items within a category that you want to appear on your chart.
This window lets you enter the Beginning and Ending Periods you want to evaluate when
you run historical analysis charts.

This window also gives you the option of selecting a Relative, Absolute or Calendar time period
for your chart.

The Relative time period requires a point of reference in order to determine which time period
is being referenced (e.g. the last three years, the most recent four quarters, etc.). This option
enables you to rerun your report in subsequent periods without changing the reference. The
default Beginning and Ending periods are O where O represents the most current time period
(e.g. annual, quarterly, monthly, etc.) for which data is available. One period prior to the current
period is indicated by [-1], two periods prior to the current period is indicated by [-2], etc.

The Absolute time period ensures that a specific time period’s data is returned (e.g. May01 for
May 2001 or YOI for fiscal year 2001).

The Calendar time period is an exact calendar year, quarter, month, week, or day. The calendar
time period is always the exact year in which the time period ends. For example, suppose a
company's fiscal year-end is May 2001. The calendar time period for annual data is 2001.

If you have selected data items with different periodicities (e.g. annual sales, quarterly EPS), this
window will also prompt you to select an alignment for the data.

Following is a description of each button displayed in this window.

Returns you to the previous window (Chart Assistant - Step 2).

Displays the Run Assistant window or your completed chart, depending
upon from where you accessed the Chart Assistant.
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Chart Window

i Hoscarch Inswht_[Hoport1]
55 [l [rt View Dot Datsbecss Tnols Windwe Lep

Dl ledles| o] o] s A 0] me 2| = |02 ] | o
am AT

Select = Modify chart
_e e_c {““ BRI B E R E R S attributes
viewing ——= 1M AR 1RUA 1 T Dz here

™ When running a chart
for multiple companies
I click on a ticker or

... Name to display the
chart for that company HEEE
I ' I N

This window displays a chart according to the companies and criteria you established in the
Research and Chart Assistants. Under the File menu, you can choose to Close or Save your
chart, create a New chart or Open an existing chart. If you close or save your file, you will be
taken out of the Research Assistant. Click the (Run) button to access the Run Assistant
window where you can modify your screening criteria for a chart. To rerun the chart with
different data items, click the (Rerun Assistant) button or select Rerun Report/Chart
Assistant from the Report menu.

options here

Click here to
view multiple
companies

by Ticker or_~ =
Name

«
H

©
2

i

o

To return to the Research Assistant click the (Research Assistant) button on the
desktop.

Below is a description of each chart toolbar button.

Copies chart to the clipboard as a bitmap

Copies data to the clipboard as text Displays chart properties dialog box
Modify chart style Change colors and patterns
Switches between 2-D and 3-D views Change fonts
Rotates chart Edit titles

Y Y

i |G| |l | *] oo 0|20 E B E HUJES| ] Ae] €0 | i
Zo+om T Horizontal grid
Z-clustered series Vertical grid

Show or hide series legend  Show or hide legend

24



Chapter 2 - Navigating Research Insight

File Open Window

Click on the
folders to
display all
predefined
reports and
charts

Open Use ight mouse chick to edit selected item.

File Open [Money Management)

™ [ Quatery Balance Sheet with Foclnates

Browse.. | NewRepor |

=] Balance Sheets d
) Annual Balance Sheet - 11 Yeas
() Annual Balance Sheet - 5'Years
) Annual Balance Sheet 5'Years with Foctnotes
] Annual Balance Sheet - 5 Years with Foolnotes & Descs
[T E

[E] Quarterdy Balance Sheet with Footnates & Descs
() YearTo'Year Percent Change Balance Sheet
# ] Cash Flow Statements
] Combined Reports
] Common Size Statemenits
-] Comparative Reports
-] Credit Analysis
|1 Eamings Estimates
gl Financial Services Repoits ll

(o}

| ety |

<ot [ ik | Camed | Heb |

This window displays when you choose the Open Report or Open Chart option on the
Research Assistant - Step 3 window or when you click the Open Report or Open Chart
button on the Research Insight desktop. From this window you can open pre-defined reports

or charts. Following is a description of each button displayed in this window.

Chart

< Back

% % S
2| |3
= m
al |
=

Finish

Allows you to open files residing in other drives.

Opens the Report Assistant - Step 1 window where you can create your

own report.

Opens the Chart Assistant - Step 1 window where you can create your own

chart.

Returns you to the previous window.

Runs and displays the highlighted report or chart.
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The Run Assistant

The Run Assistant window automatically opens before a custom report or chart is generated
when you do not pre-screen the database with the Research Assistant. The Run Assistant
window also displays after you have selected a pre-defined report or chart from the File Open
window or when you click IE (Run) to re-run a report or chart.

The Run Assistant does not guide you from one window to another. Instead, it has four stacked
tabs in one window, each of which you must click to access. With the Run Assistant, you can
create or modify the screening criteria, choose or change the set, modify the time period or view
and change the underlying Base Set and Formulas for a report or chart.

Run Assistant - Screen

Scieen | Set | Report Time Periods | Scieen - Classic View |
Comparse:s Look Up Iriitial Sed
IMSH -@I [sc CbangaSetl
Emnd Swrdlar Companies
Fashaatin Irdakul i Hdﬁ'\m'TuﬂamlFu‘ L4
Irdustiy Secton ™ Market Value IE =l I bxy j
Ell;&sugniu Seclor
o ) = =
g:gglc:wg T | F || =
Selnducty :I
S I Prica to Book. P || (5 =
S i =
T e I Prica to Sales [ = [ =
Open Sciean | Clasr | I~ Foward F/E | =] [1E0 =
DlescVion | Best | pcn e [ [ao —
Save Screen
Right-click ipticn for o
See | saess | e Customize... |

0K | Cawcel | Heb |

The Run Assistant - Screen tab allows you to create or modify the database screening criteria for
the report or chart you want to run or re-run without using the Research Assistant. This tab
contains the same buttons as the Research Assistant - Step 1 window except for the Next
button. Instead, it contains the OK button, which runs the report or chart according to the
screening criteria you just defined in the Run Assistant window. See page 13 for a description of
the remaining buttons.
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Run Assistant - Set

Hun Assistant [Money Management)
Saeen Set | Report Time Periods | Screen - Classic View |
CompanyLis——————  —Displlay Mode—  —Add Companyptosel———————————
Company Count [511 & Mames | @l
300 CovPany | I P oad Look Up
724 SOLUTIONS INC L
ACCELERS TECHNOLOGY COR
ACCLAIM ENMNT INC ~Save Sot
ACCHRUE SOFTWARE IMC
ACTFIT.COM INC Seve.. I
ACTIONPOINT IMC
ALTIVEWDRLDS COM INC Saye s
ACTMISION INC
ACTUATE CORP
ACTY INC Aesat | e oy o AndeA T
ADAM COM INC
ADEPT TECHNOLOGY INC - =
ADEXA INC ave Scieen
ADOBE SYSTEMS INC
ADVENT SOFTWARE INC EL'
AETHER SYSTEMS INC
AGILE SOFTWARE CORP Saveds.
ALLAIFIE CORP =l
B Market
Fiamaryve Company e |
Hep |

The Run Assistant - Set tab allows you to choose or change the set of companies for the report
or chart you want to run or re-run. This tab contains the same buttons as the Research Assistant
- Step 2 window except for the Next and Back buttons. Instead, it contains the OK button,
which runs the report or chart according to the set you just chose in the Run Assistant window.
See page 15 for a description of the remaining buttons.

27



Standard & Poor’s Research Insight - Getting Started

Run Assistant - Report Time Periods

Screen | Set F‘W"mmlﬁum-mﬁc\fm|

r— Time: Period

& QurertPeried  © Select Period

Alignment Periods

00

T

I3 K0 3 N KK
BLJ L0 LD L) L

[Retative
ILI.'.A
[Retative
| Fisiativa [T

Check thiz option to enable all abgnment
jpenods for the report.
F Er o [

[ ok ] coaee | Hee |

The Run Assistant - Report Time Periods tab allows you to modify the time period for the
report or chart you want to run or re-run. This tab functions like the Step 3 windows of the
Report and Chart Assistants. It gives you the option of selecting a Relative, Absolute or
Calendar time period for your report or chart.

The Relative time period requires a point of reference in order to determine exactly what time
period is being referenced (e.g. the last three years, the most recent four quarters, etc.). This
option enables you to rerun your report in subsequent periods without changing the reference.
One period prior to the current period is indicated by [-1], two periods prior to the current
period is indicated by [-2], etc.

The Absolute time period ensures that a specific time period’s data is returned (e.g. May01 for
May 2001 or YOI for fiscal year 2001).

The Calendar time period is an exact calendar year, quarter, month, week or day. The calendar
time period is always the exact year in which the time period ends. For example, suppose a
company's fiscal year-end is May 2001. The calendar time period for annual data is 2001.
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Run Assistant - Screen - Classic View

Sueen | Set | Repoil Time Peiiods - Screen - Classic View |
NS <5 ook
Base Set Size | Formula [Min|Max|Passed| Set |
1_|sC EET 9981 Linel
2 |$Linel+{"M5FT 3301 3361 Line2
3 |$line? 9981 MAICS="MSFT" MAICS 511 Lirs2
|4 |

QeenScreeni. | Qew | fun | Save Screen
ScreenView | Agset | Aunwih Lime Periods... | Emll‘ Save | SM&*|_

ok | cawel | nep |

The Run Assistant - Screen - Classic View tab allows you to view and change the underlying
Base Set and Formulas for the report or chart you want to run or re-run. This tab contains the
same buttons as the Research Assistant - Step 1 - Classic View window except for the Next and
Back buttons. Instead, it contains the OK button, which runs the report or chart according to
the Base Set and Formulas you just viewed or defined in the Run Assistant window. See page 14
for a description of the remaining buttons.
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The Look Up List

The Look Up List is a Research Insight tool that enables you to look up information about the
companies, items, functions and sets included in the database. Like the Run Assistant window,
the Look Up List is comprised of four stacked tabs. It displays when you select Look Up from
the TOOIS menu or whenever you click the (Look Up) button.

The Look Up button is found throughout Research Insight, and if you access the Look Up List
with the button, the contents of the list changes according to where the button is located. For
example,

* if you click the Look Up button in the upper right-hand corner of the
Research Assistant - Step 2 window, the Look Up List displays with only the
Look Up - Companies tab

* if you click the Look Up button on the Initial Set dialog box, the Look Up List
displays with only the Look Up - Set tab

* if you click the Look Up button in the upper right-hand corner of the
Report Assistant - Step 2 window, the Look Up List displays with the
Look Up - Items and the Look Up - Functions tabs

¢ if you access the Look Up List from the Tools menu with the Look Up button
on the Research Insight Desktop or from the Research Assistant Classic View,
it displays with all four tabs.

Buttons
All four tabs in the Look Up List contain most of the same buttons. Following is a description
of the buttons common to all tabs in the Look Up List.

Paste Pastes the company, set, item or function into the field from which you
= accessed the Look Up List.

Copy to Clipboard Copies the company, set, item or function to your computer’s clipboard
$o you can paste it wherever you want.

Close Closes the Look Up List.

Help Displays Help for the window you are in.
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Look Up - Companies

4 CS Indexes Active &
3R CS Rezearch
$R1000 Russell 1000
$R2000 Russell 2000
$R3000 Russel 3000
$5P_100

$5P_400BG Bara Gror
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35P_500
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To open the Look Up List from the TOOIS menu, select Look Up...

The Look Up - Companies tab lists every company and index in the COMPUSTAT (North
America) database by tickers and names, and by the set to which they belong. With the Look
Up - Companies tab, you can search for a company using the partial or whole name, and you

can look up the industry segment information for a company as well. This tab allows you to sort

the companies within a set by either ticker symbols or names.

The Look Up - Companies tab contains all the buttons common to the Look Up List (see page
30). In addition, it contains the Segments button, which accesses the Segments dialog box so
you can view the industry segment information for a company.
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Look Up - Items

 Select [tem Category
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To open the Look Up List from the TOOIS menu, select Look Up...

The Look Up - Items tab lists every data item and concept within the database by category, by
name and by mnemonic. With the Look Up - Items tab, you can search within a category for an
item using the partial or whole name, and you can look up the data definition for the item as
well. This tab allows you to sort the items within a category by either mnemonics or names.

The Look Up - Items tab contains all the buttons common to the Look Up List (see page 30).
In addition, it contains the Definition button, which accesses the COMPUSTAT (North
America) Data Definitions window so you can view the definition of the item.
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Look Up - Functions

Look Up x|
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To open the Look Up List from the To0IS menu, select Look Up...

The Look Up - Functions tab allows you to look up the different categories of functions (pre-
defined calculations) within the database. With the Look Up - Functions tab, you can search
within a category for a function using the partial or whole name, as well as review the definition

for the function.

The Look Up - Functions tab contains all the buttons common to the Look Up List (see page
29). In addition, it contains the Definition button, which accesses the COMPUSTAT (North
America) Data Definitions window so you can view the definition of the function.
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Look Up - Sets
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To open the Look Up List from the TOOIS menu, select Look Up...

The Look Up - Sets tab lists the sets available in the database. With the Look Up - Sets tab, you
can search within a category for a set using the partial or whole name, and you can look up any
sets you have stored outside the database on your computer or network.

The Look Up - Sets tab contains all the buttons common to the Look Up List (see page 29). In
addition, it contains the Browse button, which accesses the Open dialog box so you can view
any sets you have stored outside the database and add them to the database, if necessary.
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